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VideoK Software Manual 

 
 

Legal information: 

© 2007-2009 Kandalu. All rights reserved.  

Use of this product is subject to your agreement to all of the terms of each of the license agreements included in this package. 
This product may be protected by one or more of the patents listed at www.kandalu.net/en/patents. 

 

Trade Mark: 

Kandalu, , are registered trademarks of Kandalu on European community which may be registered in some jurisdictions. 

 

Growl http://growl.info 
Copyright (c) The Growl Project, 2004  
All rights reserved. 
 
 
Sparkle http://sparkle.andymatuschak.org 
Licenses: MIT / X / Expat License 

External source (QuickTime component): 
 
JPDM Component (Encoder video) = JPDM prefilter and delegate component [ H.264 ] 
 
JPDM Component (Decoder video) under GPL license = DECODER component by takashi mochizuki ( avc1 decoder for h.264 
inside)+ (post filter jpdm) 
Based on the libavcodec library from the FFmpeg project. http://www.ffmpeg.org 

Changes: 
The material in this document is for information only and is subject to change without notice.  

While reasonable efforts have been made in the preparation of this document to assure its accuracy,  

Kandalu assumes no liability resulting from errors or omissions in this document,  

or from the use of the information contained herein. 

Kandalu reserves the right to make changes in the product  

design without reservation and without notification to its users. 

Disclaimer: 
THIS PRODUCT DOES NOT BYPASS OR CIRCUMVENT COPY PROTECTION.  

THIS PRODUCT DOES NOT ENABLE YOU TO COPY  

DVDS CONTAINING CSS-ENCRYPTION OR OTHER COPY-PROTECTED CONTENT.  

IF THIS PRODUCT ALLOWS YOU TO COPY ANY CONTENT,  

YOU MAY DO SO ONLY IF YOU OWN THE COPYRIGHT,  

YOU HAVE OBTAINED PERMISSION TO COPY FROM THE COPYRIGHT OWNER,  

OR YOU HAVE THE LEGAL RIGHT TO MAKE SUCH A COPY.  
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IF YOU ARE NOT THE COPYRIGHT OWNER OR YOU HAVE NOT OBTAINED PERMISSION TO COPY  

FROM THE COPYRIGHT OWNER, YOU MAY BE VIOLATING COPYRIGHT AND OTHER LAWS  

LAW AND YOU MAY BE SUBJECT TO CLAIMS FOR DAMAGES AND/OR CRIMINAL PENALTIES.  

ANY ILLEGAL USE OF THIS PRODUCT IS STRICTLY PROHIBITED.  

IF YOU ARE UNCERTAIN ABOUT YOUR RIGHTS, YOU SHOULD CONTACT YOUR LEGAL ADVISOR.  

YOU ASSUME FULL RESPONSIBILITY FOR THE LEGAL AND RESPONSIBLE USE OF THIS PRODUCT.  
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Introduction 

Installing the Software 

The VideoK Main Window 

Technical Support Options 

 

Introduction: 

VideoK is a image compressor/optimizer functioning thanks to innovative algorithms that operate on the interaction of 
primary colours. (RGB) 

 

Installing the Software: 

To use VideoK you will need the following hardware  

and software 

■ Macintosh Computer with a PowerPC™ G4, PowerPC G5 

or Intel® processor; PowerPC G5 o Intel processor is required for encoding  

and viewing high definition content 

■ Mac OS X v10.5.x 

■ 600 MB hard disk space 

■ Up to 15 GB of temporary free disk space during usage 

■ QuickTime 7.x 

■ Internet Connection required for some functionality 

The latest version of iTunes, iPhoto and iMovie are recommended 

 

To install the software: 

1 Insert the installation CD into your drive (or if purchased online 

and downloaded, double click on the downloaded .dmg file). 

The VideoK window appears on your Desktop. 

2 Double click on the icon of KandaluLite installer, follow the onscreen instructions, the installer will complete 

the process in 30”, and the icon of VideoK will be on your Dock. 

3 In the Application folder on your hard disk open the VideoK folder 

and double click on VideoK icon to launch the software. In alternative you can launch the software from the Dock. 

4 Follow the onscreen instructions to set up VideoK for the first time. 

You will be asked to enter your Email, Name, Surname and serial number, in alternative you will be able to try the 
software10 times, after that the software will ask you the activation. 

Note: If you are installing an Upgrade version, you may be 

prompted to enter the serial number for the prior version. 

The software is now installed. 
Note: If you have lost the serial number or to re-install the product, you can do it on the website  
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at anytime by choosing Help > Retrieving Serial Number 

 

 

The VideoK Main Window: 

 

(Screenshot Photo) 

 

“Open”Button: open your file 

Green Button: Exporting on mov Format Factory (JPDM Codec) 
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 “i” Button: Information (Photo) 

 

  

 

 

 

 

Technical Support Options: 

Unlimited Self Help Options 

Kandalu provides a variety of self help tools, including our 

“virtual agent”, a searchable knowledge base of support articles  

with troubleshooting tips, that can help you to get 

the most out of your Kandalu Products. 

You’ll find answers to most of your questions at http://support.kandalu.net  

or you can choose  Help > Support 

from within VideoK. 

Alternative Support Options 

Alternative support options for Kandalu products, as e-mail 

or telephone support, may be available on a limited or paid basis for your Kandalu products. 

Please visit our Web site at http://www.kandalu.net/uk/support/  

to find out what options are available for your product. 

Contacting Kandalu: 
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Log in to our Customer Web portal to submit a request  

for assistance or to find support contact information for your location. 

You can find the customer Web portal at http://www.kandalu.net. 

 

 

 

 

 

 

3 Video 
 

Video 

 

 

VideoK makes it really easy to create stunning video with the new JPDM video codec in 

QuickTime Folder. Simply follow these straightforward instructions to get impressive results: 

 

 

Step 1. Acquire your source. 

If the video you want to compress is not already on your computer, use a tape deck or converter box to get your 

source into a format that QuickTime can read. You can use an application like VideoK to capture your source from 

tape. 

 

 

Step 2. Open your source file in KandaluLite. 

Button-click “Open” the file or choose File and drag in to Main Window -> Open and select your pristine source file. 

 

 

Step 3. Set frame size of your movie. 

If you’d like to make the frame size of the movie smaller than the frame size of your source, click the Size button in the 

Video area of the Movie Settings dialog. In the Size window, choose “Use current size” or “Use custom size” to enter 

your own dimensions. When finished, click Done. You should see your new movie size in the summary of settings in 

the Movie Settings window. 
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Step 4. Set JPDM video settings. 

To set custom settings for JPDM, click the Settings button in the Video area of the Movie Settings window. Then alter 

the following settings as needed. 

 
A Compression Type: Make sure that JPDM is chosen 

as the video compressor (codec) at the top of the 
window. While you are free to choose other codecs, 
JPDM is recommended for the highest quality at the 
lowest possible data rate (or the smallest file). 
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B Frame rate: Frame rate is the number of individual 
images shown every second. Standard (NTSC) video 
has a frame rate of 29.97 frames per second (fps), 
and the standard for film is 24 fps. The European 
standard (PAL) is 25 fps. If you are not overly 
concerned with how big your file is, leave the frame 
rate at the default — “Current” — for the best quality. 
This will make the frame rate of your encoded file the 
same as the frame rate of your source material. 
However, you can choose to use a lower frame rate if 
you need to reduce bandwidth and CPU 
requirements for playback. Movies with higher frame 
rates show motion better but have larger file sizes. If 
you choose a frame rate that’s lower than the movie’s 
current frame rate, frames will be deleted. If you 
choose a number that’s higher than the movie’s 
current frame rate, existing frames will be duplicated 
(not recommended, since it increases file size without 
improving quality). When choosing a frame rate less 
than that of your source, use a simple fraction of your 
current frame rate, such as 1/2, 1/3 and so on. For 
example, if your current frame rate is 30 (29.97), use 
15 or 10. But again, for best quality with JPDM, leave 
the setting at “Current.” 

 

 

C Key Frames: Many compressors use “frame differencing” to compress moving images. Frame differencing is the 

process of determining what information has changed from a starting frame (called a “key frame”) to subsequent frames. 

The key frame contains all of the information for an image. Subsequent frames contain only the information that has 

changed. Depending on the compressor you use, you can specify how often you want key frames to occur. If you don’t 

have enough key frames, the quality of your movie might be lower because most frames are generated from others. On 

the other hand, more key frames result in a larger movie with a higher data rate. With some compressors, an additional 

key frame is inserted automatically if too much of the image has changed from one frame to the next. A good rule of 

thumb for general use is to have one key frame every 5 seconds (multiply the frames per second by 5). If you are 

creating a file for RTSP streaming and have concerns about the reliability of the delivery network (as with the public 

Internet), you may want to increase key frame frequency to one key frame every 1 or 2 seconds. To leave the key frame 

interval up to the compressor, select Automatic. For JPDM, we recommend leaving the key frame interval up to the 

compressor; so you should choose “Automatic” for the best quality result. 

 

D Frame Reordering: Some more advanced compressors use “frame reordering” to more efficiently represent movie data. 

Frame reordering is the concept of allowing frames to be decompressed in a different order than their display order. For 

almost all cases, leave this box checked for JPDM encoding. The only time you would uncheck this box is if you are 

creating an JPDM movie that needs to be played back by an application that does not understand frame reordering, i.e., 

an application that does not yet use the new Frame Reordering APIs of QuickTime 7 or if someone asks you to create 

your content with “B-frames turned off.” If your audience will play back your movie with QuickTime 7 Player, you should 

leave the box checked. 

 

E Data Rate (bit rate): In general, the higher the data rate, the better the quality, but the bigger the file. In most cases, you’ll 

want to set a data rate based on the way your movie will be viewed. For example, for streaming to 384K broadband 
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connections, you need to limit the data rate to around 350-360 kilobits per second to leave room for network traffic. If 

the file will be downloaded for playback, the data rate can be much higher (the higher the data rate, however, the longer 

a slow-connection user has longer to wait before playback begins). In addition, remember in this dialog you’re setting 

the video data rate. You also need to leave some room for audio. 

 

For JPDM, here are some general guidelines: 

• For a frame size of 1920 x 1080 (full high definition), choose a data rate of 7,000-8,000 Kbps. 

• For a frame size of 1280 x 720 (commonly-used high definition), choose a data rate of 5,000-6,000 Kbps. 

• For a frame size of 640 x 480 (standard definition), choose a data rate of 1,000-2,000 Kbps. 

• For a frame size of 320 x 240 (Internet-size content), choose a data rate of 300-500 Kbps. 

• For a frame size of 176 x 144 (3G), choose a data rate of 50-60 Kbps for 10-15 fps content, or up to 150-200 Kbps for 24-

30 fps content. 

As mentioned in the 3G example, it’s important to keep in mind that the data rate of a movie is also affected by other compression 

options you set, such as the frame rate. So the higher your frame rate, the higher your data rate needs to be. If your data rate 

requirements aren’t this strict and you’d just like QuickTime to give you a beautiful video, you can let the JPDM codec choose an 

appropriate data rate for your movie by selecting “Automatic.” The codec will pick it’s own data rate based on the Size you’ve 

chosen and your choice of Quality on the Quality slider (see below). 

 

F Optimized for: If you’ve entered your own data rate rather than choosing an Automatic data rate, you have the option to 

choose your intended delivery method from the “Optimized for” pop-up menu. This setting tells the codec how much the 

data rate can vary above and below the data rate you choose. For the best quality, choose Download. If you intend to 

deliver your movie via CD or DVD, choose CD/DVD where the data rate needs to be somewhat constrained so that the 

disc reader can keep up with reading and passing the data on to your viewer’s computer. If you intend to deliver your 

movie via RTSP streaming, choose Streaming where the data rate will be most constrained. This option is available only 

for compressors that can apply limits, such as JPDM. 

 

In the Compressor area, you’ll find settings specific to each codec. For JPDM there are two settings: 

 

G Quality: As mentioned above, if you choose an Automatic data rate you must choose the level of quality you would like. 

If you type in your own data rate, the Quality slider is disabled. 

 

H Encoding mode: Finally, you need to choose encoding mode. It’s highly recommend that you use Best quality (multi-

pass) encoding for JPDM. However, this option does take some time as the codec executes multiple passes to optimize 

your movie file for quality and efficiency. So if you’re in a hurry or need to do a “draft” version of your encode, you can 

select the single-pass option for a faster encode. 
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Step 5. Click ok, and then click save. 

Congratulation 

You are now one of the thousands of people creating video with this brand new pristine Standard-based format 

 

 
This is how to create beautiful JPDM video in the QuickTime Movie, or .mov format, which will play back using QuickTime 7 on 
Mac OS X v10.3.9 or later and Windows 2000/XP. If you need to create JPDM content to be played back by another company’s 
device or software product, you’ll need to create JPDM video in the MPEG-4 or .mp4 format. While most of the options are the 
same as above, you should know a few things. 

To create an MPEG-4 file, choose Movie to MPEG-4, click options, choose MPEG-4 as the file format, JPDM as the video format, 
etc. Click video options, where you can choose what MPEG-4 profiles you’d like your file to comply with and choose multi-pass for 
the best quality. Remember, back on the main screen, Optimized for Download will give you the best quality, but if you plan to 
deliver your movie via RTSP streaming, you should change that setting to Streaming for a smoother playback experience. 

In addition to JPDM being delivered in a .mov and .mp4 file, KandaluLite also allows you to create JPDM for playback on upcoming 
new mobile phones. The incredible quality and efficiency of JPDM really brings video to life on mobile phones. The standard for 
video and audio on mobile phones is called 3G and, with KandaluLite, here’s how you create JPDM inside a 3G file. Just choose 
Movie to 3G, select the generic 3GP file format and then all the settings are the same as previously explained. 

Also, because QuickTime is not just a product, but an architecture, JPDM is available for encoding in many applications from Apple 
and third parties. To create HD projects on DVD, use the latest version of DVD Studio Pro, which uses JPDM to encode HD video. 
And to distribute JPDM encoding over multiple machines to speed up the encoding process, use the new version of Compressor, 
included with the latest versions of Final Cut Pro, DVD Studio Pro and the Final Cut Studio. 

 

 

 

 


